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A NEEDS ASSESSMENT TO DETERMINE HOW PROFESSIONALS
RATE THE FUNCTIONS OF PHOTOSHOP

An Abstract of the Thesis by
Eric Nelson Wilkinson

This study determines the rating of various Photoshop

functions by professionals who use Photoshop in their

occupation. These participants were given a survey which

asked them to rate the functions of Photoshop in three ways.

First, they were asked to rate the function by its frequency

of use, then they rated the function by its importance, and .

finally to rate the function as to whether or not it would

be needed at entry to the occupation.

The findings of this study have implications for the

teaching of Photoshop. By determining which functions are

deemed necessary for entry into the occupation and rated

high in importance and frequency of use, an instructor can

gain insight into which functions of Photoshop that need to

be taught. These entry level skills can also be viewed in

terms of their frequency of use and importance on the job.

The most general conclusion about the findings of this

study would be that nearly all of the functions of Photoshop

are rated as being important to the job to some degree. And

also, nearly all of the functions were rated as being

necessary upon entry into the occupation. This would

indicate that being exposed to all of the functions of

Photoshop would be beneficial to job performance.
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Needed at Entry:
Y=yes
N=no

Importance:
l=unimportant
2=of little importance
3=moderately important
4=important
5=very important

Frequency:
l =yearly
2=monthly
3=weekly
4=daily
5=hourly

Table IV. Image (mode) Menu (n=18)

Function Frequency
mode freq. %

Importance
mode freq. %

Entry
mode freq. %

RGB Color 5 13 72.2 5 15 83.3 Y 14 77.8
Lab Color 1 11 61.1 3 7 38.9 n 11 61.1
Multichannel 1 11 61.1 3 7 38.9 n 11 61.1
Colortable 1 11 61.1 3 8 44.4 n 12 66.7
8/16 bits 1 10 55.6 3 6 33.3 n 10 55.6
CMYK Color* 1 8 44.4 3/5 6 33.3 Y 9 56.3
Bitmap/ 1/2 4 22.2 5 8 44.4 Y 9 52.9
Grayscale* 4/5

* this f unction is multi-modal.

The Image (mode) Menu is a sub-menu found in the Image

menu . No function was rated as being frequently used aside

from RGB Col or which also was rated as being very important

a nd necessar y at entry.
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Needed at Entry:
Y=yes
N=no

Importance:
l=unimportant
2=of little importance
3=moderately important
4=important
5=very important

Frequency:
l=yearly
2=monthly
3=weekly
4=daily
5=hourly

Table V. Image (adjust) Menu (n=18)

Function Frequency
modefreq. %

Importance
mode freq. %

Entry
mode freq. %

Levels

Invert

Color Balance*

Posterize

Threshold

Equalize

Channel Mixer*

Variations

Replace Color

Brightness/Contrast*

Selective Color

Auto Levels

Hue/Saturation*

Curves*

Desaturate*

5 12
5 6
2 5
1 15
1 12
1 11
1 11
1 10
1 8
1 8
1 7
1 6
4/5 8
2/4 5
1/2/4 4

66.7
33.3
27.8
83.3
66.7
61.1
61.1
55.6
44.4
44.4
38.9
33.3
44.4
27.8
22.2

5
5
4
1

1
1
1/4
1
4
1/3/4
4
2
5
5
5

16 88.9
10 55.6
5 27.8
9 50.0
6 33.3
6 33.3
5 27.8
5 27.8
5 27.8
4 22.2
7 28.9
6 33.3
12 66.7
8 44.4
6 33.3

y
y
yin
n
n
n
n
n
o
n
n
n
y
n
n

15
10
9
12
11
13
13
11
11
9
10
10
14
9
9

83.3
55.6
50.0
66.7
61.1
72.2
72.2
61.1
61.1
52.9
55.6
55.6
77.8
52.9
52.9

* this function is multi-modal.

The Image (adjust) Menu is found as a sub-menu in the

Image Menu. Again, very little was rated as being

frequently used except for Levels and Invert. These two as

well as Hue/Saturation were the only three rated as

necessary at entry.
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Needed at Entry:
Y=yes
N=no

Importance:
l=unimportant
2=of little importance
3=moderately important
4=important
5=very important

Frequency:
l=yearly
2=monthly
3=weekly
4=daily
5=hourly

Table VI. Window Menu (n=18)

Function Frequency
mode freq. %

Importance
mode freq. %

Entry
mode freq. %

Show Layers 5 15 83.3 5 14 77.8 Y 15 83.3
Show Brushes 5 12 66.7 5 12 66.7 Y 15 83.3
Show Info. 5 10 55.6 5 9 50 Y 14 77.8
Hide Tools* 5 8 44.4 5 7 38.9 yin 9 50
Hide Options 5 8 44.4 5 6 33.3 Y 9 56.3
Show Color 5 7 38.9 5 7 38.9 Y 12 66.7
Show Channels 5 6 33.3 5 9 50 Y 12 66.7
Show Actions 5 6 33.3 5 6 33.3 Y 12 66.7
Show Swatches 5 5 27.8 5 6 33.3 Y 10 55.6
Show 1 8 44.4 1/2 4 22.2 n 10 55.6
Navigator*
Show Paths* 1 7 38.9 3/5 5 27.8 Y 10 55.6

* this function is multi-modal.

In the Window Menu we see a great number of high

ratings, with every function being rated as necessary at

entry. Two of these items, Show Navigator and Show Paths

were rated very low on frequency of use.
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Needed at Entry:
Y=yes
N=no

Importance:
l=unimportant
2=of little importance
3=moderately important
4=important
5=very important

Frequency:
l=yearly
2=monthly
3=weekly
4=daily
5=hourly

Table VII. Select Menu (n=18)

Function Frequency
mode freq. %

Importance
mode freq. %

Entry
mode freq. %

All/None/ 5 14 77.8 5 13 72.2 Y 16 88.9
Reverse
Feather 5 6 33.3 5 8 44.4 Y 13 72.2
Color Range* 3 5 33.3 3/4 7 38.9 Y 10 55.6
Grow/Similar 2 7 38.9 3 5 27.8 n 11 61.1
Modify* 3/5 5 27.8 5 6 33.3 Y 12 66.7

* this function contains multiple modes.

-.
In the Select Menu every item except Grow/Similar was

"rated as needed at entry. The function of All/None/Reverse

received very high ratings across the board while Feather

was rated high but less than one-third of the respondents.
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Needed at Entry:
Y=yes
N=no

Importance:
l=unimportant
2=of little importance
3=moderately important
4=important
5=very important

Frequency:
l=yearly
2=monthly
3=weekly
4=daily
5=hourly

Table VIII. Layer Menu (n=18)

Function Frequency
mode freq. %

Importance
mode freq. %

Entry
mode freq. %

Add Layer Mask 5
Flatten Image 5
Free Transform 5
New 5
Duplicate 5
Delete 5
Adjustment 5
Options
Merge Layers 5
Transform 5
Layer Options 5
Enable Layer 5
Mask
Merge Visible 5
Ungroup* 5
Group 5
w/Previous
Arrange 4
Matting 1

15 83.3 5 14
15 83.3 5 13
14 77.8 5 12
13 72.2 5 14
12 66.7 5 11
12 66.7 5 13
12 66.7 5 13

12 66.7 5 12
11 61.1 5 10
10 55.6 5 13
10 55.6 5 12

10 55.6 5 9
8 44.4 4/5 7
7 38.9 5 7

5 27.8 4 6
7 38.9 1 6

77.8
72.2
66.7
77.8
61.1
72.2
72.2

66.7
55.6
72.2
66.7

50.0
38.9
38.9

33.3
33.3

Y 15
Y 16
Y 15
Y 14
Y 15
Y 13
Y 13

y 15
Y 13
Y 14
Y 14

y 14
Y 12
Y 11

y 9
n 11

83.3
88.9
83.3
77.8
83.3
72.2
72.2

83.3
72.2
77.8
77.8

77.8
66.7
61.1

56.3
61.1

* this function contains multiple modes.

Almost all functions in the Layer Menu earned high

ratings in both importance and frequency as well as being

necessary at entry. The single exception is Matting which

receive low ratings and wasn't rated as being necessary for

entry.
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Needed at Entry:
Y=yes
N=no

Importance:
l=unimportant
2=of little importance
3=moderately important
4=important
5=very important

Frequency:
l=yearly
2=monthly
3=weekly
4=daily
5=hourly

Table IX. Filter Menu (n=18)

Function Frequency
mode freq. %

Importance
mode freq. %

Entry
mode freq. %

Blur
Noise
Artistic
Render
Distort
Texture
Sketch*
Brush Strokes
Video*
Other*
Stylize*
Pixelate
Sharpen*

5
5
3
3
2
2
2
2
1
1
1
1
4/5

11
8
6
6
9
8
7
6
10
9
8
6
5

61.1
44.4
33.3
33.3
50.0
44.4
38.9
33.2
55.6
50.0
44.4
33.3
27.8

5
5
3
4
2
4
2
3
1/2
1
2
2
5

11
9
6
5
5
6
9
7
5
5
10
5
8

61.1
50.0
33.3
27.8
27.8
33.3
50.0
.38.9
27.8
27.8
55.6
27.8
44.4

y 12
Y 12
Y 9
Y 10
y 9
Y 9
yin 8
n 10
n 9
yin 8
yin 8
y 9
Y 11

66.7
66.7
52.9
55.6
56.3
56.3
50.0
55.6
56.3
50.0
50.0
56.3
61.1

* this function is multi-modal.

In the Filter Menu only six of the fifteen functions

had an importance rating of three or above and only four of

them were rated with a frequency of three or above.

Although these ratings were low, only two of the fifteen

functions was rated as not being necessary for entry into

this field.
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Frequency: Importance: Needed at Entry:
l=yearly l=unimportant Y=yes
2=monthly 2=of little importance N=no
3=weekly 3=moderately important
4=daily 4=important
5=hourly 5=very important

Table x. View Menu (n=18)

Function Frequency Importance Entry
mode freq. % mode freq. % mode freq. %

---~-~---~-~-~--~~~~-------~-~-~--~-~-~------~~--------~---

Zoom In/Out 5 12 66.7 5 11 61.1 Y 12 66.7
Actual Pixels 5 6 33.3 5 5 27.8 n 10 55.6
Clear Guides* 5 6 33.3 1/3 5 27.8 n 12 66.7
Hide Rulers 3 6 33.3 3 8 44.4 Y 11 61.1
Snap to 2 7 38.9 3/4 5 27.8 n 10 55.6
Guides*
CMYK Preview 1 11 61.1 1 5 27.8 n 10 55.6
New View* 1 9 50 1/3 6 33.3 n 12 66.7
Gamut Warning* 1 9 50 1/3 5 27.8 n 11 61.1
Lock Guides 1 8 44.4 3 6 33.3 n 12 66.7
Hide Grid 1 8 44.4 3 7 38.9 n 12 66.7
Snap to Grid 1 8 44.4 3 7 38.9 n 11 61.1
Hide Path 1 7 38.9 3 9 50 n 11 61.1
Hide Edges 1 5 27.8 3 7 38.9 n 9 52.9
Hide Guides* 3/4 6 33.3 3 8 44.4 n 9 52.9
Print Size* 1/2 4 22.2 4 7 38.9 Y 9 52.9

3/4

* this function is multi-modal.

The View Menu possessed only three ratings of three or

above in frequency of use while every function except CMYK

Preview enjoys a rating of three or above in importance.

Only"three item were considered to be necessary at entry

(Zoom, Hide Rulers and Print Size).
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CHAPTER V

SUMMARY, CONCLUSIONS AND RECOMMENDATIONS

Summary

The study ranked over one hundred functions within

Photoshop as to their frequency of use, importance, and if

they were needed at entry within this occupational area.

These functions were ranked by professionals who u,se

Photoshop within their job. Businesses within the city of

Pittsburg, Kansas were used to give a total of eighteen

responses.

In chapter one research questions were put forth and

these can help to summarize this study. The first question

dealt with identifying those functions within Photoshop

that are needed by a professional using Photoshop. In the

data it was found that almost all functions of Photoshop

are used at some time or another. The respondents indicated

that every item was used to some extent. For example,

items such as ~Trap" in Table III was reported to have a

low usage and important by one-third of the respondents.
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But this means that two-thirds of the respondents rated the

~Trap" function higher than the modal response of one.

The second question to be addressed pertained to how

the professionals rated the importance of each item. The

modal response for the ~Importance" columns of the tables

seemed to basically mirror modal response of the

~Frequencyn column, but with slightly higher overall values

in the mode.

The third question dealt with the how the

professionals rated the frequency of use of each item. The

tables have been sorted in descending order by the modal

response in the ~Frequency" column. That is, those items

that have the highest rating are listed first followed by

those items that rated lower on frequency of use. Upon

viewing the tables, one can see a clear division of rated

frequency of use within each table. ·Either the functions

were rated very high or very low, for the most part.

The fourth question addressed whether the

professionals deemed the function in question to be needed

at entry to the occupation. This item again mirrors the

modal responses in the ~Importance" and ~Frequency"

columns. Those responses that tended to have a high modal

response and they also tended also to be rated as necessary

to entry in the occupation. Approximately one-third of the

26



items within Photoshop were not needed at entry into this

field.

Conclusions

While giving no clear and easily divided results, the

data do present some interesting points. First, as stated

above, almost all functions were rated as having some

importance and being used somewhat. This is like saying

that the letter ~Z" is not important or frequently used and

therefore has no use whatsoever. Every function within

Photoshop appears to have at least some value and without

even the lowest rated would have a lower level of

performance. Although there are many functions within

Photoshop, not all of them are needed at entry into this

field. It is not to say that these items are not

important, it is just a statement that these items may be

better learned on the job or that the resource for teaching

be focused on items that are needed at entry for the job.

Photoshop's power lies in large part in its

flexibility and ~open-ended" design. A person using

Photoshop has a choice of many different means to the

desired end. When students first learn about a function,

this does not mean that they are experts, but rather that

they know the mechanics of that function. The nature of

27



Photoshop makes rating the functions within it a precarious

endeavor. And, most importantly to this study, the

teaching of Photoshop has to walk this line as well. This

line can be defined as those items rated as needed as entry

and those items rated as four or higher on the other two

scales. It is important to point out that incumbent

workers may tend to exaggerate the necessity of the various

skills at entry to the occupation. Another influence might

be the emphasis -placed on different areas of Photoshop by

the differing needs of the various businesses studied.

Recommendations

The desired aim of this study was to help instructors

determine what functions within Photoshop are most

applicable for those professionals who use of Photoshop.

Perhaps the most useful aspect of the data in the context

of teaching would be to notice which functions were rated

as being necessary at entry to the job and should include

all functions rated as four or higher on the other two

scales. These ratings could be used to help emphasize what

entry level skills must be taught to prospective employees

in this area.
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Because of the ~flexible" nature of Photoshop, giving

the student of Photoshop exposure to all of the functions

of Photoshop would be very beneficial. No items on the

survey were rated as unimportant or never used, there will

be a use at some time for even the lowest rated functions.

By giving students abilities with all of the functions of

Photoshop, the student will be able to handle the flexible

and ever-changing demands put on a computer imaging

professional.

Additional studies in this area could obtain more

information on this area. Future studies might include all

of the sub-items of the main menus, especially those which

offer a control aspect to a particular function. A study

could also be performed that divided the population among

those photographic users and those pre-press users.

Another type of research would be to use the interview

method with each respondent to make sure that each menu

item is clearly understood by the respondents.
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APPENDIX A: Letter to the Panel of Experts

Mr. Sours
GIT
Pittsburg State University

Mr. Sours,

I want to thank you and the other members of this panel of

experts for taking the time and having the patience to help me to

develop this survey instrument. I sincerely wish to produce a survey

that provides meaningful data for teachers of electronic photo

manipulation, specifically with regard to Photoshop, as it pertains to

the desires of industry.

There are several points I would like for you to keep in mind

when evaluating th~s survey:

That each statement is clear and that you can understand it's

meaning.

Think about suggestions for those statements which are unclear to

you.

That you make suggestions to add or delete items from this

survey.

Make suggestions about the general appearance and format of this

survey.

My overriding concern with this survey is that it produce data

that will be meaningful and hopefully useful to teachers in this field.

Another important consideration that I have is for the survey to be

easy for the respondents to complete as I feel this will have some

bearing on it's validity and response rate. Again, thank you for you

time and input in this survey instrument validation process.

Sincerely,

Eric Wilkinson
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APPENDIX B: Cover Letter

Dear computer imaging professional,

The need for competent professionals in the area of

computer imaging is increasing. As a result, the education

of prospective employees in this field is becoming more

important. In the attached survey we hope to determine

those functions and abilities of Photoshop that are most

important. Your response as a computer imaging

professional will help to shape current and future courses

teaching Photoshop. Completing this survey will take about

15 minutes and is very appreciated. These surveys will be

picked up on April 16th. Thank you very much for your

participation in this survey.

Sincerely,

Eric Wilkinson
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APPENDIX C: The Survey Instrument:

(the survey instrument follows this page)
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Please rate each of the following functions with regard to its frequency ofuse> its importance, and if this
skill is needed at entry to the job. The rating system is as follows:

Frequency: Importance: Needed at Entry:
1=yearly 1=unimportant Y=yes
2=monthly 2=of little importance N=no
3=weekly 3=moderately important
4=dai1y 4=important
5=hourly 5=very important

TOOLBOX:

Frequency Function Importance Entry

1 2 3 4 5 Marquee 1 2 3 4 5 Y N

1 2 3 4 5 Lasso 1 2 3 4 5 Y N

1 2 3 4 5 Magic Wand 1 2 3 4 5 Y N

1 2 .3 4 5 Move 1 2 3 4 5 Y N

1 2 3 4 5 Hand 1 2 3 4 5 Y N

1 2 3 4 5 Zoom 1 2 3 4 5 Y N

1 2 3 4 5 Paint Bucket 1 2 3 4 5 Y N

1 2 3 4 5 Text 1 2 3 4 5 Y N

1 2 3 4 5 Gradient 1 2 3 4 5 Y N

1 2 3 4 5 Line 1 2 3 4 5 Y N

1 2 3 4 5 Eyedropper 1 2 3 4 5 Y N

I 2 3 4 5 Eraser 1 2 3 4 5 Y N

1 2 3 4 5 Pencil 1 2 3 4 5 Y N

1 2 3 4 5 Airbrush 1 2 3 4 5 Y N

1 2 3 4 5 Paintbrush 1 2 3 4 5 Y N

1 2 3 4 5 Rubber Stamp 1 2 3 4 5 Y N

1 2 3 4 5 Smudge 1 2 3 4 5 Y N

1 2 3 4 5 Blur 1 2 3 4 5 Y N

1 2 3 4 5 Sharpen 1 2 3 4 5 Y N

1 2 3 4 5 Dodge 1 2 3 4 5 Y N

1 2 3 4 '5 Burn 1 2 3 4 5 Y N

1 2 3 4 5 Sponge 1 2 3 4 5 Y N

1 2 3 4 5 Switch Colors 1 2 3 4 5 Y N

1 2 3 4 5 Default Colors 1 2 3 4 5 Y N
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Frequency: Importance: Needed. at Entry:

1=yearly 1=unimportant Y=yes
2=monthly 2=of little importance N=no
3=weekly 3=moderately important
4=daily 4=important
5=hourly 5=very important

EDIT:

Frequency FunetionImportance Entry

1 2 3 4 5 Import 1 2 3 4 5 Y N

1 2 3 4 5 Export 1 2 3 4 5 Y N

1 2 3 4 5 Preferences Import 1 2 3 4 5 Y N

1 2 3 4 5 Color Settings Import 1 2 3 4 5 Y N

IMAGE:

Frequency Functi.onImportance Entry

1 2 3 4 5 Duplicate 1 2 3 4 5 Y N

1 2 3 4 5 Apply Image 1 2 3 4 5 Y N

1 2 3 4 5 Calculations 1 2 3 4 5 Y N

1 2 3 4 5 Image Size 1 2 3 4 5 Y N

1 2 3 4 5 Canvas Size 1 2 3 4 5 Y N

1 2 3 4 5 Crop 1 2 3 4 5 Y N

1 2 3 4 5 Rotate Canvas 1 2 3 4 5 Y N

1 2 3 4 5 Histogram 1 2 3 4 5 Y N

1 2 3 4 5 Trap 1 2 3 4 5 Y N

IMAGE (mode):

Frequency FunctionImoortance Entry

1 2 3 4 5 Bitmap/Grayscale 1 2 3 4 5 Y N

1 2 3 4 5 RGB Color 1 2 3 4 5 Y N

1 2 3 4 5 CMYKColor 1 2 3 4 5 Y N

1 2 3 4 5 Lab Color 1 2 3 4 5 Y N

1 2 3 4 5 Multichannel 1 2 3 4 5 Y N

1 2 3 4 5 8/16 bits 1 2 3 4 5 Y N

1 2 3 4 5 Colortable 1 2 3 4 5 Y N
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Frequency: Importance: Needed at Entry:

1=yearly 1=unimportant Y=yes
2=monthly 2=of little importance N=no
3=weekly 3=moderately important
4=daily 4=important
5=hourly 5=very important

IMAGE (adjust):

Frequency FunctionImportance Entry
1 2 3 4 5 Levels 1 2 3 4 5 Y N

1 2 3 4 5 Auto Levels 1 2 3 4 5 Y N
1 2 3 4 5 Curves 1 2 -'3 4 5 Y N
1 2 3 4 5 Color Balance 1 2 3 4 5 Y N

1 2 3 4 5 Brightness/Contrast 1 2 3 4 5 Y N
1 2 3 4 5 Hue/Saturation 1 2 3 4 5 Y N

1 2 3 4 5 Desaturate 1 2 3 4 5 Y N

1 2 3 4 5 Replace Color 1 2 3 4 5 Y N

1 2 3 4 5 Selective Color 1 2 3 4 5 y N

I 2 3 4 5 Channel Mixer 1 2 3 4 5 Y N

1 2 3 4 5 Invert 1 2 3 4 5 Y N

1 2 3 4 5 Equalize 1 2 3 4 5 Y N

1 2 3 4 5 Threshold 1 2 3 4 5 y N

1 2 3 4 5 Posterize 1 2 3 4 5 Y N

1 2 3 4 5 Variations 1 2 3 4 5 Y N

WINDOW:

Frequency FunctionImportance Entry

1 2 3 4 5 Hide Tools 1 2 3 4 5 Y N

1 2 3 4 5 Show Navigator 1 2 3 4 5 Y N

1 2 3 4 5 Show Info. 1 2 3 4 5 Y N

1 2 3 4 5 Hide Options 1 2 3 4 5 Y N

1 2 3 4 5 Show Color 1 2 3 4 5 Y N

1 2 3 4 5 Show Swatches 1 2 3 4 5 Y N

1 2 3 4 5 Show Brushes 1 2 3 4 5 Y N

1 2 3 4 5 Show Layers 1 2 3 4 5 Y N

1 2 3 4 5 Show Channels 1 2 3 4 5 Y N

1 2 3 4 5 Show Paths 1 2 3 4 5 Y N

1 2 3 4 5 Show Actions 1 2 3 4 5 Y N
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Frequency: Importance: Needed at Entry:

1=yearly 1=unimportant Y=yes
2=monthly 2=oflittle importance N=no
3=weekly 3=moderately important
4=daily 4=important
5=hourly 5=vety important

SELECT:

Frequency Functi.onImportance Entry

1 2 3 4 5 Al.IINonelInverse 1 2 3 4 5 Y N

1 2 3 4 5 Color Range 1 2 3 4 5 Y N

1 2 3 4 5 Feather 1 2 3 4 5 Y N

1 2 3 4 5 Modify 1 2 3 4 5 Y N

1 2 3 4 5 Grow/Similar 1 2 3 4 5 Y N

LAYER:

Frequency FunctionImoortance Entry

1 2 3 4 5 New 1 2 3 4 5 Y N

1 2 3 4 5 Duplicate 1 2 3 4 5 Y N

1 2 3 4 5 Delete 1 2 3 4 5 Y N

1 2 3 4 5 Layer Options 1 2 3 4 5 Y N

1 2 3 4 5 Adjustment Options 1 2 3 4 5 Y N

1 2 3 4 5 Add Layer Mask 1 2 3 4 5 Y N

1 2 3 4 5 Enable Layer Mask 1 2 3 4 5 Y N

1 2 3 4 5 Group w/Previous 1 2 3 4 5 Y N

1 2 3 4 5 Ungroup 1 2 3 4 5 Y N

1 2 3 4 5 Free Transform 1 2 3 4 5 Y N

1 2 3 4 5 Transform 1 2 3 4 5 Y N

1 2 3 4 5 Arrange 1 2 3 4 5 Y N

1 2 3 4 5 Merge Layers 1 2 3 4 5 y N

1 2 3 4 5 Merge VISible 1 2 3 4 5 Y N

1 2 3 4 5 Flatten Image 1 2 3 4 5 Y N

1 2 3 4 5 Matting 1 2 3 4 5 Y N
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Frequency: Importance: Needed at Entry:
1=yearly 1=unimportant Y=yes
2=monthly 2=oflittle importance N=no
3=weekly 3=moderately important
4=daily 4=important
5=hourly 5=very important

FILTER:

Frequency Funeti.onImportance Entry

1 2 3 4 5 Artistic 1 2 3 4 5 Y N

1 2 3 4 5 Blur 1 2 3 4 5 Y N

1 2 3 4 5 Brosh Strokes 1 2 ·3 4 5 Y N

1 2 3 4 5 Distort 1 2 3 4 5 Y N

1 2 3 4 5 Noise 1 2 3 4 5 Y N

1 2 3 4 5 Pixelate 1 2 3 4 5 Y N

1 2 3 4 5 Render 1 . 2 3 4 5 Y N

1 2 3 4 5 Sharpen 1 2 3 4 5 Y N

1 2 3 4 5 Sketch 1 2 3 4 5 Y N

1 2 3 4 5 Stylize 1 2 3 4 5 Y N

1 2 3 4 5 Texture 1 2 3 4 5'- y N

1 2 3 4 5 Video 1 2 3 4 5 Y N

1 2 3 4 5 Other 1 2 3 4 5 Y N

VIEW:

Freguency FunctionImportance Entry

1 2 3 4 5 New View 1 2 3 4 5 Y N

1 2 3 4 5 CMYK Preview 1 2 3 4 5 Y N

1 2 3 4 5 Gamut Warning 1 2 3 4 5 Y N

1 2 3 4 5 ZoomIn/Out 1 2 3 4 5 Y N

1 2 3 4 5 Actual Pixels 1 2 3 4 5 Y N

1 2 3 4 5 Print Size 1 2 3 4 5 Y N

1 2 3 4 5 Hide Edges 1 2 3 4 5 Y N

1 2 3 4 5 Hide Path 1 2 3 4 5 Y N

1 2 3 4 5 Hide Rulers 1 2 3 4 5 Y N

1 2 3 4 5 Hide Guides 1 2 3 4 5 Y N

1 2 3 4 5 Snap to Guides 1 2 3 4 5 Y N

1 2 3 4 5 Lock Guides 1 2 3 4 5 Y N

1 2 3 4 5 Clear Guides 1 2 3 4 5 Y N

1 2 3 4 5 Hide Grid 1 2 3 4 5 Y N

1 2 3 4 5 Snap to Grid 1 2 3 4 5 Y N
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